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TECHNICAL SUPPORT: 

Support phone number: (714) 543-9877 

Support e-mail: support@liaisonsc.com 

Website: www.liaisonsc.com 

Required Keyword: (you’ll need to read this manual)  
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1 – LIAISON MESSENGER® OVERVIEW 

Whichever machine will be running 

Messenger Server the PC will require 
Microsoft SQL Server or Pervasive.SQL (or 
Btrieve) client engines installed, licensed and 
functional.  

REQUIREMENTS FOR OUTPUT 
CAPABILITIES 

Messenger provides four methods of 
distribution; printing, faxing, e-mailing, and archiving. In order to optimally take advantage of some of 
these features there are certain components you may need to acquire. 

PRINTING 

Messenger allows you to configure and send each part (ply) of a form to a different printer. Messenger 
supports the (UNC) Universal Naming Convention. This means that you are not limited by standard 
DOS conventions.  If you have multiple laser printers in other departments, try enabling the Printing by 
Ply for each of the forms. You will love the convenience of not having to burst, decollate, and deliver 
forms to the various departments. 

FAXING 

In order for Messenger to transmit forms via facsimile, an external 
Fax Manager is required. We currently support a number of 
different solutions:  

Symantec’s WinFax PRO 10.01/10.04 from Symantec. With a 
single license running on the Liaison Messenger Server PC, 
Messenger can turn WinFax PRO into an unattended Forms Fax 
Server.  A DEDICATED PHONE LINE attached to an internal or 
external modem is also required. 

Microsoft Fax Transport in conjunction with Microsoft Outlook 
2000 or newer. 

Fax Servers that support Microsoft Outlook’s add-in capabilities 

Like RightFax, GFI or Zetafax.  
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Internet faxing subscriptions like: Data On Call 

In System Configuration, you can configure Messenger to utilize anyone of these methods. 

ARCHIVING 

An interesting and quite useful feature of Liaison Messenger is it’s unique archiving ability. Instruct 
Messenger to archive (to disk) each form that gets 
processed. You simply create and then designate a 
unique directory/folder for each company dataset and 
for each form. Similar to the file format options for e-
mailing, Archiving is best used in conjunction with the 
PDF file format. 

When Messenger prints the form, it can create an 
electronic copy of that form in the designated 
directory using a simple file name convention. The 
first 2 characters identify the Form Type; the next set 
of characters is the Customer/Vendor key. Now, the 
next set of characters will be the first document 
number in that customer/vendor’s run followed by the 
last number in the run. Finally a Date stamp is added 
to ensure uniqueness. Delimiting these character sets 
are hyphens. 

This allows the user to easily retrieve a previously printed Invoice, Sales Order, or P.O. and either Print, 
E-mail, or Fax a copy of the original. 

In a nutshell, Archiving would allow a user to quickly retrieve a previously printed invoice for, let’s say 
Advantage Golf Pro Shop, Invoice 00023.  

In Windows Explorer, navigate to K:\MYACCTSYS\TWO_INC\ARCHIVE\INVOICES and scroll down to 
the Customer Key ADV01, the first Invoice in the run is 00023 and the last is 00027. The invoices were 
printed: 06/04/2002.  

IN-ADV01-00023-00027-20020604.PDF 

Also available from within Messenger Client is our Archive Manager. To access any previously archived 
form(s), choose the Archive Manager from the File menu of Messenger Client.  This utility will show all 
archived forms as specified in Properties for each form and allow you to easily view, print, e-mail, or fax 
and archived form.   

Liaison Messenger now has 6 different archive naming conventions which can be specified. 
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Liaison Messenger® consists of two components; Messenger Server and Messenger Client. You can 
think of Messenger Server like you would a PAS, Application Server, or Process Manager depending on 
the respective Accounting 
System terminology. Like a 
PAS, the Messenger Server 
must be running in order to 
print, and post if required, any 
forms (i.e., any of the above 
invoices, sale orders, etc.).  

We recommend placing a 
shortcut for Messenger Server 
in the Startup folder on the 
Windows NT/2000/XP/Vista 
workstation acting as the 
Messenger Server machine. 

MESSENGER TERMINOLOGY 

Before we get started, please note the following Print Job terms we use here and what we are referring 
to.  

New - Orders and Invoices that have never been printed.  

Rerun - Orders and Invoices that have been printed but not posted can be Rerun. Invoices have been 
assigned their Invoice Number, so a rerun merely prints the invoices again. (This option only applies to 
users of PFW and BatchMasterPFW systems.) 

Recreate - this is used for orders and invoices that have already been printed and posted.  Also, the 
Recreate feature is only available for orders and invoices that have not yet been purged from your 
Accounting System. Unlike rerunning a job, which is a batch run, recreates work on one order/invoice at 
a time. 

A Recreate does not get routed to the pre-designated printers like New and Rerun jobs. The form is sent 
to a local printer via a standard Print Dialog box, and only the first ply is reprinted. 

If you have been using the Archive capability of Messenger, you could easily retrieve and reprint the 
previously printed order or invoice through the Messenger Archive Manager, Windows Explorer and /or 
Adobe Acrobat reader.  

MESSENGER SERVER 

We require running the Liaison Messenger Server on a Windows NT/2000/XP/Vista Workstation or 
Windows NT/2000/2000/2003/2008 Server. We say the server because typically those units are the 
most powerful computers on the network. Remember, Messenger can be configured to service all forms 
for all users. In early tests, Liaison Messenger consumed, on average, about 5% to 7% of the server’s 
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resources. Running the Messenger Server on a Windows 98/95 PC, we noticed a significant resource 
consumption loss after about 150 print jobs that could result in a fatal error. Windows NT does not 
realize this resource consumption problem. 

Messenger Server can operate in two modes; one as an Unattended Forms Server and the other a 
Print-On-Demand Server. In the later situation, end-users utilize Messenger Client to make the 
Requests to print or reprint forms On-Demand. 

The Unattended Server operates on a pre-determined schedule planned by the end-user or systems 
administrator. A typical schedule might be to Print all unprinted New Orders, Back Orders, and Quotes 
every 2 hours. In this manner, users would simply enter orders and Messenger Server would print, 
route, fax, and or e-mail those forms at the designated intervals. 

Being that Messenger Server operates on one machine, in order to route, fax and e-mail to all devices, 
this computer must be 
mapped to all printers. 
Messenger supports the 
Universal Naming 
Convention (UNC). This 
allows Messenger to access 
all printers (DOS/Windows) 
configured on the server. It 
allows users a sufficient 
number of printers; local, 
network, and remote 
connected and accessed via 
the NT/2000/XP server. 

If the faxing and e-mailing 
capabilities will be used, only 
one license of the fax or mail 
client would be required.  

When the e-mailing portion of Messenger is enabled, the machine e-mail client/account should be 
configured with a messenger@companyname.com user name. This will help facilitate sending, receiving 
and tracking of the forms routed via e-mail and their possible return-receipts.Messenger Client 

The Messenger Client component is run from each workstation that will be printing or reprinting forms. It 
has a single-window interface. End users initiate New, Rerun, and Recreate print jobs in Messenger 
Client. 

Any New and Rerun job requests are serviced by Messenger Server and routed to the appropriate 
devices. 

The Messenger Client processes Recreates of forms for Preview and Print options, locally. However, 
when a Recreate is requested to fax or e-mail the form, this job request is (internally) placed in the main 
processing queue which is monitored by Messenger Server.  
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This way (since the Messenger Server is doing the fax or e-mail) only a single user license of the fax 
software, Outlook, or PDF writer software is required to service the request of an unlimited number of 
users. 
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2 ‐ LIAISON MESSENGER SYSTEM SETTINGS 

The first time you launch Messenger Server you may be greeted with the System Configuration screen. 
This allows you to establish global system-wide defaults Messenger will use.  These Defaults will also 
be used when running in Unattended Server mode. They also establish the preset selection when 
printing from the Messenger Client utility. 

If you ever need to change the system settings once Liaison Messenger has been setup and configured, 
you can always choose the System Configuration option from the File menu from within Messenger 
Server. The System Configuration option is not available from Messenger Client. 

SYSTEM CONFIGURATION 

MESSENGER 

Here it is recommended that a 
Default Printer is assigned to 
each of the different form types 
displayed on the Messenger 
tab. 

If you wish to and keep the 
rest of the options at their 
default. This includes the 
Interval setting of 0 and the 
Increment setting to Off. 

Please refer to the respective 
Chapter in this guide that 
relates to your individual 
accounting system and/or operating environment. 

FAXING 

From the System Configuration window select the Faxing tab. Specify your Area Code and any outside 
line prefix. As we stated earlier, WinFax PRO 10.01/10.04, Microsoft Fax Transport, and almost all 
commercial Fax Systems/Servers with Outlook Add-In clients are currently supported. However, if you 
have a fax server that supports X.25 addressing, we can most likely interface to the product, please 
contact us for details. 
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10‐DIGIT DIALING SCHEMAS 

If you are in an area that uses 
10-digit dialing, enter the Area 
Codes, separated by 
commas, and NO spaces in 
the designated field. When 
Messenger encounters a 
phone number from that area 
code, it will NOT add a 1 to 
the beginning of that number. 

NON‐TOLL 
EXCHANGES/PREFIXES 

If you are in an area that has 
area codes where some 
prefixes are long distance and 
some are local (non-toll) calls. Enter the prefixes (exchanges), separated by commas, and NO spaces in 
the designated field. When Messenger encounters a phone number with that prefix within your Area 
Code, it will NOT add a 1 to the beginning of that number. 

IF USING WINFAX PRO, PLEASE PERFORM THE FOLLOWING: 

LOCATE WFXCTL32.EXE 

Found in the main fax manager folder. This is by default located in the c:\Program 
Files\Symantec\WinFax folder. 

FAX PRINTER DRIVER 

Now choose the Winfax (printer) driver. When you are done, select Save. Do NOT select the “Send Via 
Fax” option. You must select the printer driver of the fax program. 

FAX DRIVER DELAY 

Do not change unless advised by our technical support personnel.  

FAX COVER SHEETS 

Under the Messenger and/or SalesSonar tabs you can specify a Cover Page for each form type. These 
cover sheets are created in the WinFax PRO application under the Tools menu. 

If you elect to use a WinFax PRO cover sheet, make SURE you remove the “Fill Text” blocks within the 
cover page. If you are unsure how to do this please call our technical support department.  Failure to do 
this may cause WinFax PRO to pause and prompt the file server to manually enter “Text” for each form 
that Messenger is try to send. 

STANDARD FORM FILL FOR RECREATES 
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This cover page option should reference a cover page with the “Fill Text” option. This way the end-user 
can add a message to the cover sheet before the Reprint is faxed to the recipient. 

E‐MAILING 

From the System Configuration 
window select the E-mailing 
tab. If you only have one e-mail 
user profile on this machine, 
leave the e-mail Address, From 
E-mail Name, and Account 
Password blank.  Messenger 
will use the default profile 
automatically. However if 
multiple profiles are configured 
on this PC, you will need to fill 
in those fields. These fields are 
Case Sensitive. 

Since Messenger sends forms via e-mail attachments, you need to specify the Format. We strongly 
recommend you keep the Liaison Messenger PDF attachment printer driver as defaulted. However, you 
may use Adobe Acrobat 4.x or 5.x if desired.  Liaison Messenger will not work with Adobe Acrobat 6.0 
or above. 

Once created, Adobe PDF files are viewable but not modifiable the standard Adobe Acrobat reader 
which is freely available. 

Another option is PCL/PRN. This would require the recipient to copy the PRN file to the printer on their 
site or use a PCL viewer. 

Please keep in mind that should you elect to transmit copies via e-mail, you should select a blank paper 
template so that the lines, titles, and borders print around the text/data appear on the form. 

Since we recommend keeping the Liaison Messenger PDF attachment printer driver as defaulted. 
However, you may use Adobe Acrobat 4.x or 5.x if desired. 

Next select the attachment type (Adobe PDF Writer 4.0/5.0, Generic PDF, PCL, TXT, Liaison PDF 
Writer) and you are done. 

STATEMENTS (AKA LIAISON COLLECTOR) 

Please refer to the Chapter on Liaison Collector in this guide for configuration instructions. 
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ARCHIVING 

FROM THE SYSTEM CONFIGURATION WINDOW SELECT THE ARCHIVING TAB. 

Again, since Liaison Messenger now includes a PDF writer, we strongly recommend you keep the 
Liaison Messenger PDF archiving printer driver as defaulted. However, you may use Adobe Acrobat 4.x 
or 5.x if desired.  Liaison Messenger will not work with Adobe Acrobat 6.0 or above. 

Archiving allows a user to 
quickly retrieve a previously 
printed form without having to 
reprint the form through 
Messenger.  

When Messenger prints the 
form, it will create an 
electronic copy of that form in 
the designated directory 
using a simple file name 
convention. The first 2 
characters identify the Form 
Type; the next set of 
characters is the 
Customer/Vendor key.  

Now, the next set of characters will be the first document number in that customer/vendor’s run followed 
by the last number in the run. Finally a Date stamp is added to ensure uniqueness. Delimiting these 
character sets are hyphens. 

Also available is the Archive as Individual Files…. Option. This is used so that documents are not 
archive in their respective batch run. 

PDF ENCRYPTION 

We recommend that you keep this option disabled.  Users who do not have the most current Acrobat 
Reader would not be able to open or read the documents.  The encryption is 128-bit for those interested 
in using this feature. 

ADVANCED 

Here you can specify Auto-Add capabilities for the Customer and Vendor address book and establish 
default business rules for assigning Recipient Preference defaults by form type. 
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Another option on this screen 
allows you to setup snoozing 
time for Messenger.  This will 
automatically shutdown or set 
as inactive, Liaison Messenger, 
for a certain time frame.  This is 
primarily used for system 
backups on off-hours.  If auto-
quit is used, you must manually 
restart the Server or use a 3rd 
party application launcher. 

 

 

 

DATABASE 

IF THIS IS A PERVASIVE.SQL INSTALLATION THE DATABASE TAB IS NOT USED. 

If this is a Microsoft SQL Server install of MAS 200, Microsoft Dynamics GP/SBF or Microsoft Dynamics 
SL, select the Database tab and enter the Data Source name you created using the ODBC 

Administrator or Manager for 
the System Database. Also, 
enter the User ID and 
password as it relates to the 
data source you created.  You 
can ignore the Database and 
Company fields as these are 
generally handled under the 
actual ODBC connection you 
create. 

 

RESTARTING THE 
SERVER 

 

Once you have finished making any changes  within System Configuration and selected the Save 
picture icon, the server should automatically start. The server will automatically start every time you 
open the Messenger Server. 
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To stop the server, select Stop Server from the File menu or the Stop Server icon on the toolbar. There 
you can also restart the server manually with the Chasing Green Arrows icon. 

IF YOU ARE STARING AT A GREEN LIGHT, YOU’VE DONE EVERYTHING RIGHT. GOOD 

JOB! 

 

 

 

 

 

 

 

ENABLING/DISABLING COMPANY DATASETS 

The next step, but most important, is 
which companies you want to automate. 
By default, all companies you’ve 
established in your Accounting System 
have not been enabled. To practice, we 
strongly recommend enabling the system 
test databases first. You can then properly 
setup, configure, modify, and test 
Messenger before implementing it through 
Cloning.. 

 

Once you’ve gotten your configuration 
working on the test company and you 
want to implement it on the live company, simply select the Clone Company Properties from the File 
menu and replicate that configuration on the live company dataset. 
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Refer to the appropriate section on the two databases depending upon your specific installation. 

CONFIGURE BACKEND DATABASE 

Depending on the backend database your accounting system is using Messenger will act in one of two 
possible manners 

Pervasive.SQL 

The first time you select this option, you may be prompted for the location of PFW, BatchMasterpfw 
and/or Microsoft Dynamics GP/SBF. Enter main the location of accounting application database.  

 

For of PFW and 
BatchMasterpfw, Liaison 
Messenger is attempting to 
locate the 
x:\platinum\admin\utmcfile to 
bring in the respective 
companies already 
established. 

 

Microsoft SQL Server 

From the File menu in 
Messenger Server 
choose, Select Company 
Dataset. If the System 
Data Source name you 
specified in System Configuration is correct, you should be seeing all the companies in your accounting 
system. 

 

For each company you wish to process under Messenger: 

 

1. Highlight the record and choose the Edit button. 

2. Place a check in the Enabled for Messenger/SalesSonar or EFT.  

3. Specify Backend Database and select SQL Server tab (if applicable). 

4. Set the desired available options/settings (outlined below) for the specific accounting system you 
are linking. 
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By default, the “Collating” options you see listed for the forms are unchecked. This is the preferred 
method for processing forms. If you want forms collated by form number, please call technical support 
before enabling because certain time-saving features of Messenger have to be disabled in order to 
accommodate this method. Very few people use this option. 

 

PFW OR BATCHMASTERPFW COMPANY OPTIONS 

If BatchMasterPFW is used for this company, place a check in the Enabled for BatchMasterPFW option. 

 

MICROSOFT DYNAMICS GP/SBF COMPANY OPTIONS 

If the Microsoft Field Service Module for Dynamics GP/SBF is being used and data needs to be bridged 
on the standard forms, select this option.  Also, if this company needs to include data from the Customer 
Item X-Ref table, enable this option. 

 

Microsoft SQL Server 

If this is a Microsoft SQL 
Server install of Microsoft 
Dynamics GP/SBF select the 
SQL Server tab and enter the 
Data Source name you 
created using the ODBC 
Administrator /Manager for 
this company, the User ID 
and password.  You can 
ignore the Database and 
Company fields as these are 
generally handled under the 
actual ODBC connection you 
create. If this is a 
Pervasive.SQL installation the SQL Server tab is not used. 

 

MICROSOFT DYNAMICS SL COMPANY OPTIONS 

Liaison Messenger interfaces with Dynamics SL’s Order Management module by inserting equivalent 
Steps in the SO Steps table, which is defined for each Order Type. The two options we have that load 
and remove these steps are: 
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 Remove Messenger Steps in Dynamics SL 

 Load Messenger Steps in Dynamics SL 

 

When either is checked, Messenger will Remove and/or Load these steps into the SO Steps database.  
By default, all options are in Bypass mode. This to prevent unwitting Order Process changes.  To enable 
the forms processing options, you will need to invoke these Liaison Messenger Steps by setting the 
respective option to “Required” in Order Type maintenance in Dynamics SL. 

 

Microsoft SQL Server 

Select the SQL Server tab and enter the Data Source name of the Application Database you created 
using the ODBC Administrator /Manager for this company, the User ID and password.  You can ignore 
the Database and 
Company fields as 
these are generally 
handled under the 
actual ODBC 
connection you create. 

CONFIGURE REMAINING 
COMPANY DATABASES 

Repeat the above 
steps for ALL 
Companies you wish to 
enable and process with 
Liaison Messenger.  

TESTING COMPANY DATA PATHS OR DATA SOURCE CONNECTIONS 

Once you have configured your company datasets in 
System Configuration and Company Configuration, 
you will want to test the connections. From the File 
menu choose Select Company Dataset. Starting with 
the 1st “enabled” dataset highlight the respective 
company and choose the Select button. 
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Then select from the File menu, the Properties option. Go to each Form Type tab and select the Preview 
button. 

 

If system paths for Pervasive.SQL or data source 
ODBC drivers for Microsoft SQL server have been 
properly setup, you will be seeing soon previewing 
forms with actual data. 

 

Please note that if data does NOT exist in the 
company you are testing no forms will be able to be 
previewed. 

 

If the Path or ODBC data source connection is invalid, 
you’ll be receiving an error message with a corrective action description. If you do not receive an error 
but can’t view any forms, the most logical reason is not having any test data in the select dataset. 

Repeat these steps for each Company Dataset and correct any mapping issues (if any) before 
proceeding with the rest of the installation. 

CLONING COMPANY CONFIGURATIONS 

Here are the steps for turning on your live company and copying the properties from the test company. 

1. SETUP AN ODBC THAT DEFAULTS TO THE LIVE COMPANY DATASET  

2. In Messenger go to File | Select Company Dataset 

3. Single click on Live company and choose Company Configuration 

4. Check Enabled for Messenger box 

5. Choose SQL Server tab 

6. Type ODBC name, ID and Password for Live company ODBC 

7. Click Save 

 

8. Double click Live Company to Select 

9. Click No when asked to Restart Server 

10. Go to File | Clone Company Properties 
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11. Click yellow lookup button and select Test company as Source Company 

12. Click yellow lookup button and select Live company as Target Company 

13. Check the boxes for the Forms to Include 

14. Click the Clone button. 

15. A message will prompt you when cloning is complete.  Click OK 

 

16. Next you will need to load in the Customer, Vendor and Salesperson data from the Live company. 

17. Go to File | Properties 

18. Click the Customers tab  

19. Click the Add button - an Import window will open 

20. Click the Import button 

REPEAT FOR THE VENDOR AND SALESPERSON TABS. 
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3 – PROPERTIES; RECIPIENT PREFERENCES 

CUSTOMER AND VENDORS 

In order to fax or e-mail customers and 
vendors, they must be established in 
the Messenger Address book. 

On the Properties windows are tabs for 
Customers and Vendors as well as 
other recipients. Each tab allows you 
to Add, Configure, or Remove 
recipients. 

IMPORTING RECORDS 

Selecting the Add button will call the 
Import dialog box. Messenger will import from your linked Accounting System the respective customers 
and vendors based upon the criteria you selected.  

Once imported, 
their fax numbers 
and e-mail 
addresses will be 
maintained in 
Messenger. You 
can always go back 
and refresh missing 
Customers or 
Vendors whenever 
you wish.  

Once you’ve 
imported your 
recipients you will 
want to establish 
defaults for them. 
Highlight the 
respective records 
and select the 

Update button. You could also double-click the record. 
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CONFIGURING INDIVIDUAL PREFERENCES 

Each Customer and Vendor is different. Some customers might want their Invoices printed and mailed 
but want their Order faxed as Acknowledgements. They might also have a different fax number or e-mail 

address for each of their forms. 
You can determine these 
settings on this screen. Please 
note that changing any value 
here will not affect your linked 
Accounting System databases 
even though the data originally 
came from your Accounting 
System.  

Once you’re satisfied with your 
configuration, select the Save 
button to record your changes. 

A similar screen is available for 
vendors. This is performed on 
from the Vendors tab. The 
vendors screen is a little easier 

in that it only deals with Purchase Orders.   
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SALESPEOPLE, TERRITORIES, AND LOCATIONS 

IMPORTING RECORDS 

In order automatically route to Salespeople, Territories, and Locations, they must be established in the 
Messenger Address 
book. On the Properties 
windows are tabs for 
Salespeople, Territories, 
and Locations as well as 
Customers and Vendors. 
Each tab allows you to 
Add, Configure, or 
Remove recipients.  

Selecting the Add button 
will automatically bring in 
these codes from the 
linked Accounting 
System.  

CONFIGURING 
INDIVIDUAL PREFERENCES 

Like customers and vendors, Messenger allows you maintain individual fax numbers, e-mail address, 
and default printers for each Salesperson, Territory, and Location. This also includes unique settings for 
each form type. 

 

Using the new Salespeople, 
Territories, and Locations 
preferences allows you to 
easily identify and route to 
these recipients or locations. 
In Properties you can now add 
routing options like ‘Send to 
Salesperson’, ‘Send to 
Location’, etc… Messenger 
will create the needed filters 
and route to the respective 
recipient in the manner you 
specify (e.g. e-Mail, Fax, or 
Print). 
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GLOBALLY CONFIGURING CUSTOMER AND VENDORS PREFERENCE 

Fax and Email on Default line are pulled from Customer Card/Bill To Address ID 

These are maintained in your accounting system. 

Note: if an email/fax is changed in GP it will be updated for the customer in Messenger when a 
document is processed for the customer.  If the field is blanked out in GP the value WILL NOT be 
erased in Messenger.  The value will need to be deleted in Messenger and the preference will need to 
be change. 

Values set under the Messenger tab take precedent over the Default line. These are maintained in 
Messenger and do no write back to Great Plains. 

Examples:   

Sales Ord’s pref set to Faxed with 714-543-0887 as the fax number would fax Sales Orders to 714-543-
0887. 

Invoice pref set to 
E-mailed with no 
email address on 
Invoice line 
would email 

Invoice to the 
address on the 
Default line. 

Statements pref set 
to Default.  This will 
read the Default line 
and Stmt will 
print. 

 

There is also an 
Alternate 
Preference field which follows the same rules.  See page 2 below for Ply Routing settings related to the 
Alternate Preference. 
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The Ply Configuration | Routing tab settings determine which Customer Preference is used. 

With a Printer set as the Routing Method and a Cascade of ‘Use Recipient’s Preference’ the ply will be 
routed to the preference set for the customer. 

You also have the option of sending the ply to the preference if the National Account. 

 

 

With a Printer set as the 
Routing Method and a 
Cascade of ‘Use Alternate’s 
Preference’ the ply will be 
routed to the Alternate 
preference set for the 
customer. 

You can choose to have the 
fax/email address read from 
the values on the customer 
screen (User Preference 
Override) or you can select 
to have the fax/email read 
from the Ship To address ID 

set on the order/invoice. 

Note: the ‘collate by order number’ option must be selected in Company Configuration for the Ship To 
selection to work properly. 

 

 

With a Routing Method 
set to Send Copy Via 
Email or Send Copy Via 
Fax the same rules will 
apply except the 
Customer Preference 
must match the Routing 
Method in order for the 
ply to process. 

In other words, if the 
Routing Method is set to 
Send Copy Via Email and 
the Customer Preference 
is set to Emailed the ply 
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will process.  If the Customer Preference is set to Faxed or Printed the ply with a Routing Method of 
Send Copy Via Email will not process. 
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In Sales Transaction Entry click the blue arrow to the right of the Customer ID 

 

 

Messenger pulls the email/fax based on the Bill To Address ID on this screen per document 
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From the Customer and Vendor Tab there is a Set Pref… button. Use this feature to globally configure 
the routing options for the recipients. 

 

 

Here you can globally change or update Customer/Vendor preferences based on their Status.  

AUTOMATICALLY ADDING NEW CUSTOMERS AND VENDORS 

You can instruct Messenger to automatically add new Customers, Vendors, etc… to the Recipient 
Address book and establish pre-defined rules for new recipients. 

For example you may want to 
automatically set all new 
customers to receive Invoices 
via Fax if a Fax Number is 
present. Maybe you want 
Sales Order 
Acknowledgements e-mailed. 
You choose the rules and 
Messenger will follow them. 

 

This feature can be turned on 
in System Configuration on 
the Advanced tab. 

 

Steps to globally set recipient preferences. 

Use the Set Pref button on the Customers tab in Properties to globally change the preferences. 

It will be run once for each preference.  The first run will be for the most desired routing. 

Example1: Choose All Customers in the ‘Existing’ section and Emailed for the Statement ‘To 
Preference’ the click Proceed. 

This will change the preference to Emailed for any customers that have an email address. 
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The second run is for the other routing.    

Example2: Choose All Customers  = Default/Printed for the ‘Existing’ and Faxed for the Statement ‘To 
Preference’ 

This will change the preference to Faxed for and customers with a fax that are not already set to 
Emailed. 

Any that do not have a fax or email will stay as default/blank and will be printed. 
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Thank you for reading this manual the hidden keyword is Bratwurst. Now you are entitled to receive 
Technical Support. 
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4 – PROPERTIES; PLIES, ROUTING, FAXING, EMAILING 

ESTABLISHING WORKFLOW AUTOMATION ROUTES 

Messenger is tightly integrated into your Accounting System. Evident of that are the form defaults and 
form templates included in Liaison Messenger.   

SETTING‐UP FORMS 

In Messenger Server choose from the File menu, Properties. The first thing you want to do is establish 
which printers each ply will be routed. On the Forms tab you’ll find a number of tabs. One for each Form 
Type Each form can have from 1 to 9999 plies. But, keep in mind that these are no longer pre-printed 
forms. Messenger’s plies are really destination points or actions, as you will discover. 

FORM LAYOUT, ROUTING, AND CONFIGURATION… 

From the Properties screen you will have a tab for each form type grouping. Under each form type will 
be plies simulating a 3 or 4 
part form using the Blank 
Paper template option of each 
form.   

By default Liaison Messenger 
includes form templates that 
look 100% like your existing 
pre-printed forms of your 
accounting system.  

To establish a routing, change 
a template, specify a data 
block-out scheme, or create a 
routing filter highlight the 
respective ply and choose the 
‘Config’ button. 

On the Form Ply Configuration window you will see 7 tabs which are described below. 

APPEARANCE 

Configuring each ply is probably the most enjoyable feature of Messenger. You have complete control 
over most aspects of the form. You could print on Blank Paper or utilize your existing pre-printed forms.  
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If you’re configuring the ply to be faxed, you can specify a constant fax number or leave it blank to route 
it to the respective customer or vendor’s fax number.  

TEMPLATE LIBRARY 

Choose the form layout you wish to use. The options with Blank Paper allow you to use standard paper 
and messenger will print the 
lines, boxes, and titles 
around the data. Pre-Printed 
options, of course, only print 
the data. 

CUSTOM TEMPLATE 

These Templates allow you 
to create or modify a layout to 
be used for this ply only. 
Perhaps you want to print a 
special form whenever a 
Purchase Order is printed. 
This form may not resemble a 
P.O., but it will contain data 
that is present on a P.O. You 
create a custom form so that 
it will print every time a P.O. prints. You could even create a filter so that this custom form only prints if a 
field has a particular value (i.e., location=”0005”). 

 

RETURN ADDRESS 

If you are using a Blank Paper Form template, specify if you want Messenger to: 

- Print Company Name (and Address) of the Company Dataset 

- Logo format: BMP is preferred but JPG is also OK, a JPG image will be a larger file  size. 

- Image Resolution: At least 150 dpi.   

- Logo Size:  No size restrictions but prefer the logo image size to be as close to the image size that will 
appear on the form. 

- Specify Logo .BMP 

- Print Nothing (using preprinted letterhead) 

 

MARGINAL WORDS 
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You can change the Marginal Words that print at the bottom of each form. If you want to create a 
“custom” marginal word, go back to the Properties screen and type directly into the Marginal Word 
column of the Ply grid, your custom text. 

ALTERNATE HEADING 

If you want the heading of the form for this ply to be different, type it in hear. For example, you may wish 
the Customer Copy of a Sales Order to be titled, Acknowledgement. Here is where you would make that 
change. 

Do Not Print Lines and Borders 

Place a check to toggle the line and borders on the form. Used primarily on plies with Custom Template 
selected. 

ROUTING 

Choose the respective Printer you wish to send the ply to. It is VERY important NOT to select Winfax, 
Fax, Liaison PDF driver, or Adobe PDFWriter.   Doing so will cause Messenger to prompt the user for a 
file name or fax number on the Server. The Fax, Winfax, and Liaison PDF printer drivers are setup in 
System Configuration. 

CASCADE (FAX, OR E­ MAIL, 
OR PRINT) 

If you want the ply to have 
a multi-function 
capability (fax or e- mail 
or print) based upon the 
customer or vendors 
preference, set the 
Cascade option of this 
ply to Use 
Recipients 
Preference. When 
Cascade is set to This 
Device Only, the ply will 
only send the form to the 
designated Routing 
Method. Cascade allows 
you to incorporate logical switching or branching. This way Messenger will look at the properties of each 
customer or vendor and route the ply accordingly. 

 

Aside from the printers you’ve installed into the Control Panel and the Cascade feature, you also have a 
number of unique Routing Options that you may wish to implement: 

Send Copy Via Fax 
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If want to (only) fax the ply and not print or e-mail it, choose this option. Do NOT choose the Fax (ie., 
WinFax) printer driver, as Messenger will not pass the respective phone number to the printer driver. 

If you want all copies of the ply to be faxed to a specific fax Number, enter that fax number in the 
Constant Fax/E-mail/Archive/Disk/Data Folder field. 

If you want a copy of the ply to be faxed to a customer or vendor, that recipient’s preference must be set 
to receive the form(s) by fax and have a valid fax number. If the intended recipient is not setup to 
receive the form via fax, the ply is ignored. 

Send Copy Via E-mail 

If you want to (only) e-mail the ply and not print or fax it, choose this option. Do NOT choose the Liaison 
Messenger PDF or Adobe Acrobat printer driver. 

If you want all copies of the ply to be e-mailed to a specific e-mail address, enter that e-mail address in 
the Constant Fax/E-mail/Archive/Disk/Data Folder Only field. 

If you want a copy of the 
ply to be e-mailed to a 
customer or vendor, that 
recipient’s preference 
must be set to receive the 
form(s) by e-mail and have 
a valid e-mail address. If 
the intended recipient is 
not setup to receive the 
form(s) via e-mail, the ply 
is ignored. 

ARCHIVE COPY TO DISK 

If want to electronically 
store a copy of the form to 
disk, you will want to 
choose this option. Specify the destination folder in the Constant Fax/E-mail/Archive/Disk/Data field of 
where you want the forms stored. Make sure you have properly setup the Archiving under System 
Configuration first. 

 

SEND COPY TO SALESPERSON 

This routing method works similarly to the Cascade feature for Customers and Vendors.  However, it 
groups all documents by the assigned salesperson key and routes the forms in the manner you’ve  
determined on the Salespersons section of Messenger Properties.  Each salesperson can be setup to 
receive any form via e-mail, fax, or printed to a local or remote printer.  You can also suppress any form 
type or salesperson(s) from this option, too.  



I N S T A L L A T I O N  G U I D E  

 

36 

Liaison Messenger® v4.0 

 

Imagine automatically sending 
Sales copies of to the 
respective salesperson (in-
house or remote) with no user 
intervention. 

SEND COPY TO TERRITORY 

This routing method works 
similarly to the Send Copy To 
Salesperson routing method.  
However, it groups all 
documents by the assigned 
territory key and routes the 
forms in the manner you’ve determined on the Territory section of Messenger Properties.  Each 
grouping can be setup to receive any form via e-mail, fax, or printed to a local or remote printer.  You 
can also suppress any form type or territory(s) from this option, too.  

 

Imagine automatically sending Sales copies of to the respective sales manager (in-house or remote)  
with no user intervention. 

SEND COPY TO LOCATION (AKA SITE) 

Again, this routing method 
works similarly to the Send 
Copy To Salesperson routing 
method.  However, it groups 
all documents by the 
designated Location (or Site) 
key and routes the forms in the 
manner you’ve determined on 
the Location or Site section of 
Messenger Properties.  Each 
grouping can be setup to 
receive any form via e-mail, 
fax, or printed to a local or 
remote printer.  You can also 
suppress any form type or 
territory(s) from this option, 
too.  

Imagine automatically sending Picking Tickets to the respective warehouse (local or remote) with no 
user intervention. Talk about Just-In-Time processing. 
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SEND DATA TO DISK 

Use this method to route the “data” of the form to disk. You can output the form in the following file 
formats. 

 SDF 

 Excel Spreadsheet 

 dBase/Foxpro 

 Comma Delimited 

 Space Delimited 

 Tab Delimited 

 

Specify the destination folder in the Constant Fax/E-Mail/Archive/Disk/Data field of where you want the 
data files stored. 

 

You also have control over what is output to disk; the Header (BillTo/ShipTo) data, Detail (line items, 
qty, price, etc) data or both. 

 

If you wish to Send Data File to Disk as Individual Files by Recipient, choose the option of the same 
name on this screen. Otherwise, the entire batch will be written to disk in a single file output file. 

 

Send ASCII Form to Disk 

This routing method is similar to 
Send Data to Disk. However, 
instead of providing a data file of 
the form, it creates a Text based 
image of the form. This option is 
useful for those companies using 
legacy form conversion programs 
that interface into heterogeneous 
systems. 

 

If you wish to Send ASCII Form 
to Disk as Individual Files by 
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Order/Invoice Number, choose the option of the same name on this screen. Otherwise, the entire 
batch will be written to disk in a single file output file. 

 

DATA  

If you wish to block out monetary amounts from the form plies, select the Data tab for each ply and 
Check and/or Uncheck the desired fields listed on the screen. By placing a check next to the field, 
Messenger suppress (or block-out) the value(s) fields from printing on the form. 

FILTER 

Filtered routing is a very powerful feature of Messenger.  You can specify certain plies to print, fax, e-
mail, or archive ONLY when a certain condition exists.   

You can create filtered routing for each form ply. Select the Filters 
tab to enter the expression in the Expression Builder. The syntax 
is dBase format. Please refer to the Database Dictionary for all 
fields available and their respective data types. 

 

Simply repeat these 
options for each ply of 
every form you wish to 
automate. Once 
configured, you can forget 
about it. 

 

For example, perhaps you want every salesperson to receive a 
copy of Sales Orders entered for accounts to which they are 
assigned. This copy is to be faxed or e-mailed. 

You simply would add a ply and choose Send copy via “Fax or E-mail” and then create a Filter.   

In the example to the right, we are creating a filter that would send a copy to the salesperson that has 
Salesperson Key 00001.  You could then create an additional Ply for each salesperson and enter a 
unique filter that matches each Salesperson Key. 

Another example could be as follows. You want to use the International Customs Invoice template for all 
shipments going UPS outside of the United States.  And have this print when you run Sales Order 
Invoices. 

Simply add a new ply to SO Invoice, select the International Customs Invoice from the Template Library.  
Let’s say your ship via code for UPS is  “U”.  Select the Filters tab add a filter as follows.   
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Lmdoeh.shipviakey="U".AND.Lmdoeh.shipcntry#"USA" 

Here we are saying only print this Ply (International Customs Invoice) when the Invoice’s ship via code 
is “U” and the Ship To Country field is Not equal to “USA”. 

 

ATTACHMENTS 

Here is where you can 
enhance the e-mailing and 
or faxing capabilities on a 
ply-by-ply basis. You can 
assign specify a unique 
Cover Sheet for faxing to 
a particular ply, template, 
or user-defined condition 
you’ve created with the 
filter expression 
capabilities.  

 

If this ply will be e-mailed, 
you can specify up to 1 
Variable file attachment and or 4 more (or 5 static) static attachments that will accompany a e-mailed 
form. Perhaps you would like to include Certificate of Compliance spec sheet or Terms and Conditions 
file.  Maybe send a Credit Application to all customers that are not setup on terms or are in a prepay 
status when the invoice is e-mailed. 

Maybe if they bought a certain inventory class, you would like to attach a special offer or promo and 
have it expire in 2 months.  
The solution is as easy as this 
is written. 

E‐MAIL TEXT 

This tab is used to create a 
special e-mail subject and text 
body for e-mails sent from this 
ply.  This will over-ride any 
default e-mail subject/body 
text specified in System 
Configuration. 

 

SORTING 

If you want to change the 
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order of how the form plies are printed, choosing this drop down list will provide you with different sorting 
options. 

 

 If you need to create a sort which drop down list does not contain you can create a custom sort by 
choosing the Custom Sort… button. 

 

Here you will be brought to the Expression Builder window. Un-like creating a filter expression, which 
must evaluate to either a True/False statement, an Index expression must evaluate to the same Data 
Type. This means if you sort expression will contain character and numeric data types, a data 
conversion function will be needed to convert the numeric values to characters. 

Fields are strung together in order of their sort priority.  

Unless you have a good reason, always start your expressions with the COMPID field. This field 
identifies the company data set you’re printing from.  In the above example, we are creating a sort AND 
grouping that will generate a “summary invoice”. Regardless of the Invoice numbers, we want the line 
items grouped by customer key then item key. 

If you are not creating summary style documents, you will want to create sorts that have the respective 
document number field AS THE 2ND field like: Lmdoel.COMPID+Lmdoel.ORDNO+Lmdoel.LINESEQ. 

Under the Help menu, you will find the PDF versions of all the Data Fields and the correct Syntax for 
referencing the data form you specific Accounting System. 
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5– AUTOMATED AR STATEMENTS (AKA LIAISON COLLECTOR) 

ENABLING LIAISON COLLECTOR 

From the File pull 
down menu, select 
System Configuration.  

 

 

STARTING 
COLLECTOR 

To Start Collector set 
the Auto-Send 
Statement and 
Minimum days 
between Statements 
to a value greater 
than 0 and select the 
Save button. 

Based upon the 
Collector Preference, Collector will print, fax, or e-mail a Statement of Accounts to the recipient if their 
outstanding balance(s) go over the Auto-Send number of Days.  Specify the Aging Date as of Current 
Date or the Previous End-of-Month. 

EXCLUDING CUSTOMERS 

To prevent Collector from sending a Statement to customers should the delinquent amount be deemed 
insignificant, you can specify a percentage of the Total AR that must be exceeded before a statement is 
auto-sent. 

Customers can also have individual settings. These customer settings are maintained in Properties 
under the Customers tab and then by selecting the Update button.  

ESTABLISH THE COLLECTOR STATEMENT ROUTING RULES 

Once you’ve done the above steps, refer to the Chapter titled Print, Fax, Email, & Routing to create your 
create your business rules for each AR Statement form template and ply. 
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CONFIGURE AUTO‐INVOICE ATTACHMENT FEATURE 

On the Messenger Server, go into the Properties windows and create an Archive ply for Invoices and 
SOP Invoices. 

1. An Invoice ply must first be set to ‘Archive Copy to Disk’ 

2. Check ‘Force Variable Attachment Naming Convention’ 

3. Create and specify a location for these newly archived Invoices 
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After you've created an archiving ply for the AR and SOP invoices, you will need to establish an 
emailing ply for the Statements that will attach and/or append these archived invoices. 

So from within Properties you should select the Statements tab and  select the Customer Ply. 

 

 

 

 

 

 

 

 

Attachments tab of Statement archive copy 

1. Type = Variable 

2. Variable Schema = Statement Invoices 

3. Ext. = PDF 

4. ‘Merged’ selected from drop list. 

5. SOURCE: select location of archive folder that contains the invoice PDF files to attach 

6. TARGET: contains path where invoice PDF files will be moved after being attached to statement.  
This is used so the invoice will only be attached once. 

IF NO TARGET PATH IS SPECIFIED THE INVOICE PDF FILES WILL BE ATTACHED 

WITH THE NEXT STATEMENT PROCESSING IF THE INVOICE NUMBER STILL 
APPEARS ON THE STATEMENT. 
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6 – MESSENGER EFT‐AP/DD* (MICROSOFT 
DYNAMICS GP ONLY) 

Messenger System Configuration  (*Additional Purchase 
Required) 

If you’ve purchased the EFT-AP or EFT-DD module, it must be 
enabled in the System Configuration screen.  

ENABLING EFT‐AP (ACCOUNTS PAYABLE) 

To enable the EFT-AP module 
for Messenger, place a check 
in the respective EFT-AP  
Enabled box on the EFT-
AP/DD tab in System 
Configuration. 

Messenger EFT-AP or EFT-
DD will print, fax, or e-mail an 
EFT-AP Notice to the 
respective vendor or email 
and EFT-DD paystub to the  
employee whenever the 
Electronic Payment process is 
performed in Microsoft 
Dynamics GP. 

After you’ve enabled the 
module, you should specify a default printer, the desired polling interval and increment and the check 
the Update Notification Send Date fields. 

INCLUDE/EXCLUDE VENDORS 

The Vendor’s preference must be specified in Recipients Preferences in order for them to receive the 
EFT notice via email or fax. This can be done by selecting this option from the menu in Messenger 
Client, Messenger Server, or under the Messenger Properties Vendor tab. 

ESTABLISH THE EFT ROUTING RULES 

Once you’ve done the above steps, refer to the Chapter called Print, Fax, Email, & Routing to create 
your business rules for each EFT form template and ply.  

In System Configuration | EFT-AP/DD tab the EFT module is enabled and configured. 

Check the ‘Update Notification Sent Date’ to advance the ‘Last Date’ field after the EFT processes.  This 
is used to determine if an EFT notice has been printed. 
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The Default Printer is used 
as a backup in case one of 
the printers selected in 
Properties is unavailable. 

The Interval and Increment is 
set to establish how often 
Messenger will poll for 
unprinted notices. You can 
also specify a Start Time 
and/or a Delay based on the 
date.  

In the example, Messenger 
will poll every 24 hours at 
2:00AM for any EFTs that 
generated after the ‘Last 

Date’ and ‘Last Time’ displayed 
in Messenger.  The ‘Last Date’ 
and ‘Last Time’ will be updated 
in Messenger after the notices 
have been processed. 

The Ply Configuration and 
Vendor preferences use the 
same rules as the other form 
types. Refer to the chapter that 
covers Properties for further 

instructions. 

Messenger Client can be used 
to manually process the EFT 
notices manually by Batch 
number. 

To run as a replacement to the 
automatic processing check the 
‘Update Date/time of Last 
Transmission’ box.  This will 
update the Last Date and Last 
Time fields in System 
Configuration. 

Checking ‘Ignore Last Process Date’ will allow any previously printed notices to be reprinted. 

The ply number can also be specified.  Leaving the field blank will process all plies defined on the EFT-
AP tab of Properties. 
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EFT‐DD (DIRECT DEPOSIT) 

Messenger EFT-DD is enabled under the EFT-AP/DD tab of System Configuration. 
A default printer should be selected.   A network printer is best.  Do not choose ‘Liaison Messenger 

PDF’ or any other virtual print driver. 

The Interval and Increment fields along with Start Time 
are used for scheduling Messenger to automatically poll 
for new DD ACH files.  The Client can also be used to 
select the ACH batch when ready. 

Employee information is read from the Employee card 
in Dynamics GP. The emails address pulls from the 
internet information window (italics i to right of address 
ID) The Password field is also read from this window.  
Emailed PDFs of DD advice will require this password 
in order to open the attachment.  If no password exists 
the PDF will open without a prompt. 

 
Under File | Properties | Employees tab the 
employees are imported using the Add button. 
This can also be accessed from Client – File | 
Set Recipient Preferences.   
 
NOTE: Each time a new employee is added to 
GP that is setup for direct deposit or a new 
email address is entered for an existing 
employee the Add button will need to be clicked 
to refresh the list. 
The buttons on the left filter the list for the 
purpose of determining which employees do not 

have ‘Emailed’ set as the 
preference but have an email 
address. 

Each employee record has its 
own preference screen.  The 
EFT-DD tab contains the Direct 
Deposit preference selection list.  
An employee can have a 
preference of Emailed or 
Suppress.  Blank selections will 
be treated as printed.  (see ply 
routing for more details) 

Under the EFT-DD tab of 
Properties the plies are 
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configured.  Each ply consists of various components which are unique to that ply. In the example below 
there is an employee copy routing to the employee’s preference and an archived copy creating a PDF 
file in the path specified. 

Double click the ply to 
open the configuration 
window.  Under the 
Routing tab the employee 
copy would have a 
routing of ‘Send Copy to 
Employee’.  This will send 
via email if the employee 
preference is set to 
‘Emailed’.  If the 
preference is set to 

‘Suppress’ that employee’s notice will not 
be sent.  A blank employee preference 
will be treated as Printed and route to the 
Default printer specified on the EFT-
AP/DD tab of System Configuration. 

If no printed copy is desired for 
employees without emails a 
filter can be placed under the 
Filters tab to ignore these 
printed copies and only send 
the emailed copies.  Syntax:  
LMDDFT.DDPREF=4 

The Subject line and body text 
for the employee email are 
entered under the Email Text 
tab. 
The DD advice number is 
automatically appended to the 
end of the subject line.  To 
suppress this number check 
the box on the bottom right. 
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An archive copy is created by 
selection ‘Archive Copy to Disk’ for 
the routing method.  The path 
where the archived PDF file is to be 
stored is selected by clicking the 
yellow lookup icon to the right of the 
Target field.   A UNC path can also 
be used by typing the path directly 
in the Target line. 

To add a new blank ply click the 
Add button.  To copy an existing ply 
single click the ply to copy then click 
the Clone button.  A new ply will be 
created with the same configuration 
as the one cloned. 
To remove a ply single click the ply then click the Delete button. 
The Preview and Test Print buttons are used to check the layout.  In the TWO test company all data will 

appear.  In all other 
companies data specific to 
the employee is 
suppressed for security 
purposes. 
 

The DD advice template 
can modified by clicking 
the Modify Layout button.   
Refer to the section on the 
report designer in the main 
configuration guide. 

The Messenger Client is 
used to submit the job to 
the queue on Messenger 
Server to process the DD 
advice notices. 

 
The yellow lookup icons are used to select from the number listing.  The ACH index number is used to 
select the batch but the check build date is displayed to make the search easier. Clicking the column 

headings will sort 
by the column 
clicked. 
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Check the ‘Ignore Last Process Date’ box 
to reprint older batches that have already 
been sent. 
The Ply No. selection can be used to only 
process the ply selected.  For example: to 
only resend the archive copy without 
resending the employee copy. 

Once all parameters have seen selected click the 
‘Process’ button to submit the job to the Messenger 
Server queue.   A confirmation window will appear 
indicating the job has been sent to the queue. 
The Messenger Server must be open and on the Green 
status light in order for the job to process. 
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7 – LIAISON QUEUE REQUESTER 

Adding Messenger Client capabilities to other programs is easily accomplished 
with command line options. From Print Document windows to Recipient 
Preferences settings, you have complete control of Messenger Server without 
source code. 

By simply calling the LiamQue.exe executable and passing additional 
arguments (or parameters) you can control Messenger Server from other 

applications or directly from within a screen of your Accounting System. Perhaps you would like to add a 
Quick Print, Fax, or E-mail command button. 

Here is the full syntax, you do not need to include "" to surround text strings.  Argument D1 and D2 are 
optional. These are document over-ride parameters you could pass. 

 Parameter S1 is a constant string. It relates to the Company ID assigned to that Company 
Dataset. 

 Parameter S2 is a constant string. Do not end the path with a \, Messenger will automatically add 
it.  

 Parameter P1 is a constant (SOP,POP,IVC,SD, or ST) for the respective module.  

 Parameter P2 and P3 are variable data types relative to the document. 

BASIC SYNTAX:  

<d>:\Messnger\LiamQue.Exe S1 S2 S3 P1 P2 P3 D1 D2 

 *S1=Company ID 

 *S2=Path to Messenger Queue 

 *P1=MESSENGER FORM TYPE (SOP,POP,IVC,SD,ST) 

 *P2=<GPDOC_TYPE>    Do NOT Include the <brackets>, use the proper database reference 
from Dexterity 

 *P3=<GPDOC_NUMBER>  Do NOT Include the <brackets>, use the proper database reference 
from Dexterity 

 *D1=DOCUMENT ROUTING OVERIDE 
(1=ROUTE,2=PRINT,3=FAX,4=EMAIL,5=ASCII,6=EXPORT) 

 *D2=ROUTING (UNC),FAX NUMBER (999) 999-9999, EMAIL ADDRESS, FILE NAME FOR 
D1>=3 
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USING MODIFIER OR VBA 

Adding Messenger Client capabilities to other programs is easily accomplished with command line 
options. From Print Document windows to Recipient Preferences settings, you have complete control of 
Messenger Client without source code. 

If  you wish to add a Quick Print button to the Document entry screen that will place a Print Request for 
that order into the Messenger Queue, using Modifier or Dexterity, here is a sample VBA code  

Dim sCmd 
Dim sDoc 
        sDoc = DocumentNo 
        Save = 1 
        sCmd = "\\DSIMSSQL\Messnger\LIAMQUE.EXE SAND \\DSIMSSQL\Messnger SOP! 2 " & sDoc 
        MsgBox sCmd 
Shell (sCmd) 
   

 For SOP Docs it would be:  

 X:\MESSENGER\LIAMQUE.EXE TWO X:\MESSENGER SOP! 2 <DOC NUMBER>  

            1                                    2            3               4     5          6  

1. Path to Queue Requester  
2. Company ID  
3. Path where Messenger is installed  
4. GP document type (exclamation point tells it to ignore if document has already been printed)  
5. SOP TYPE (2=Order, 3=Invoice) Can be placed back to back i.e. 23 would print either Order or Invoice  
6. SOP Number  

You could also add # after the doctype to not update TIMESPRT as the example below illustrates: 

C:\MsgrGPtest/liamque.exe TWO C:\MsgrGPtest SOP# 2 ORDST2286   

 For Purchase orders, the syntax would be:  

 X:\MESSENGER\LIAMQUE.EXE TWO X:\MESSENGER POP! 1234 <DOC NUMBER>  

            1                                    2            3              4       5              6  

 Path to Queue Requester  

1. Company ID  
2. Path where Messenger is installed  
3. GP document type (exclamation point tells it to ignore if document has already been printed)  
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4. POP Status (i.e. Open, Released, Closed etc.) Can be placed back to back i.e. 1234 would print all but 
Cancelled POs 

5. POP Doc Number  
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8 – 3RD PARTY ADD‐ON PRODUCTS  

TECHNICAL SUPPORT 

As much as we would like, Liaison Software Corporation cannot provide technical support 
on Acrobat, Outlook, and WinFax PRO. We can answer some basic questions as it relates to 
Messenger; however, the actual publisher of their respective product(s) always provides the best 
support and should be used. 

As a software publisher, Liaison Software Corporation urges you to comply with all software-licensing 
provisions of the products we recommend and or sell. Unauthorized use of software is a crime. 

ADOBE ACROBAT 

Even thought Liaison Messenger now includes a licensed PDF Writer from Amyuni, Liaison Messenger 
still works with Adobe Acrobat 4.x and 5.x. Messenger will not work with Acrobat Distiller. It mVust be 
the PDF writer. One area you need to check (or uncheck really) is the Save PDF File As dialog box. 

When using the archiving or e-mailing feature in 
Messenger with Adobe Acrobat you must ensure that 
View PDF File option is turned off (unchecked) in 
Acrobat’s Save PDF File As dialog box. To turn this 
option off, you must follow these instructions:  

Login to the PAS as Administrator. No other login 
name will make this setting.  

1. Open up Microsoft Word or WordPad 

2. Select File, Page Setup, then Printer… 

3. Choose the Acrobat PDF writer as the printer destination 

4. Print the document 

5. Uncheck the View PDF File 

MICROSOFT OUTLOOK/OUTLOOK EXPRESS 

For e-mailing, this mail client seems to be the most popular.  Even though Messenger will work with 
most any MAPI compliant e-mail program, Microsoft Outlook and Microsoft Outlook Express have been 
most successful. When installing, only setup one User Profile. 
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Multiple user profiles will require you to enter the E-mail address, Account Name, and Password in 
System Configuration under the E-mail tab. 

If only on user profile is created, Messenger will utilize these setting with no prompting. If you must have 
multiple profiles on this PC, please keep in mind that Messenger and Outlook are case sensitive in their 
settings. 

Also ensure that the Outlook/Express client has access to the Internet and no user prompts requiring 
intervention appears. These types of interruptions can cause Messenger errors and disrupt the flow pf 
the business forms. 

SYMANTEC WINFAX PRO 

If you are planning on faxing forms with Symantec’s WinFax PRO, only one copy of WinFax PRO is 
needed and must be loaded on the PC that is acting as the Messenger Server. 

In System Configuration under the Faxing tab make sure that the WinFax PRO option is selected for 
Fax Server/Application . 

IMPORTANT – Please note that Symantec will only support WinFax PRO on Windows NT/2000 
Workstation. Symantec will NOT provide support WinFax PRO on a Windows NT/2000 Server. 

We do not know why… 

The only post installation configuration we recommend is setting the number of Retries on a failed fax to 
between 5 and 10. The set the minimum seconds between retries to about 500. This helps WinFax in 
making sure that all faxes, which failed due to busy numbers, can be successfully resent. 

MICROSOFT FAX TRANSPORT 

If you are planning on faxing forms with Microsoft Fax Transport, you’ll also need to install one copy of 
Microsoft Outlook. Microsoft Fax Transport does not work with Outlook Express.  Please refer to the 
documentation for Microsoft Fax Transport and Outlook for the most current installation requirements 
and procedures. 

In System Configuration under the Faxing tab make sure that the Microsoft Fax Transport option is 
selected. 

LIAISON CRM 

Liaison CRM was developed by Liaison Software Corporation and is fully integrated with Liaison 
Messenger for PFW. You can instruct Messenger to update the Liaison CRM Notebook of each 
Customer when a Sales Order, Invoice, and Statement are generated. To enable this feature follow the 
instructions below. 
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From the File menu choose Company Configuration. Select the Liaison CRM Location tab. Enable and 
enter the path of where the Liaison CMDCFG.DBF file in the Liaison Folder.   

Then choose the Company Dataset in Liaison that is linked to the PFW or BatchMasterPFW Company 
Dataset you are configuring. 

When done, choose Save and proceed to System Configuration from the File menu.  

Select the Advanced tab and then Liaison CRM interface. Choose the desired forms to update the notes 
file. When done choose Save. 
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9 ‐ CUSTOMIZING FORMS 

PLACE ADDITIONAL ACCOUNTING 
SYSTEM DATA ONTO A FORM  

Liaison Messenger lets you access 
additional fields and tables from your 

installed Accounting System and place the desired 
field(s) onto a form. To access these tables open the applicable 
databases and place them into the data environment screen. The 
table listing later in this chapter illustrates the databases that can 
be opened for each form. 

 

From the Properties screen click the modify layout button 

From the reports controls tool bar choose the field button. When the cursor is brought on to the form the 
cursor will change into cross marks. Left click and draw a box. This will bring you into the report 
expression.  

Choose the button to the right of expression field. You are now in the expression builder. In the bottom 
left corner will be a fields list which contains all the fields that can now be accessed and brought on to 
the form you are modifying. Refer to the database dictionary for definitions of each field. 

Double click on a field and click OK 

MESSENGER PRINT TABLE LISTING 

AR INVOICES/CREDIT MEMOS 

LMDARH.DBF   AR Invoice Header Structure Master 

LMDARL.DBF   AR Invoice Detail Structure Master 

SALES ORDERS, QUOTES, SHIPPERS, AND INVOICES 

LMDOEH.DBF   SO Order & Invoice Header Structure Master 

LMDOEL.DBF   SO Order & Invoice Detail Structure Master 

PURCHASE ORDERS 

LMDPOH.DBF   Purchase Order Header Structure Master 

LMDPOL.DBF   Purchase Order Detail Structure Master 
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FORM DESIGNER 
Use the Form Designer to create and modify custom Form Templates. When the Form Designer window 
is active, Messenger displays the Report menu and the Report Controls toolbar.  

To modify an existing ply’s layout, choose Modify Layout in the Forms Configuration Wizard. To create a 
new custom form layout, from the Ply Configuration window choose Custom Template and then the 
Create Custom Ply Template. 

Below is a brief description of the Form Designer. 

BANDS 

By default, the Form Designer displays three bands; Page Header, Detail, and Page Footer. A separator 
bar is located at the bottom of each band. The name of the band type appears on the bar next to a blue 
arrow, which indicates that the band is above, not below, the bar. 

You can add the following bands to your Form. 

Band  Printed  Typical Contents

Column 
Header 

Once per 
column 

Column title

Column 
Footer 

Once per 
column 

Summary, totals

Group Header  Once per group Preface to following data

Group Footer  Once per group Calculated values for group 
data 

Title  Once per 
report 

Title 
Date or page number 
Company logo 
Box around the title 

Summary  Once per 
report 

Grand totals
Text such as Grand Totals 

 

RULER 

The Form Designer has a vertical and horizontal ruler you use to more precisely position objects in the 
bands. Use the ruler in conjunction with the View menu's Show Position command to help you position 
objects. 



I N S T A L L A T I O N  G U I D E  

 

58 

Liaison Messenger® v4.0 

 

The scale for the ruler is determined by your system measurement settings. You can change from the 
system default scale (inches or centimeters) to pixels from within Messenger. If you want to change to 
the system default, change the measurement setting for your operating system. 

TO CHANGE THE RULER SCALE TO PIXELS 

From the Format menu, choose Set Grid Scale. The Set Grid Scale dialog box is displayed. 

In the Set Grid Scale dialog box, select Pixels and choose OK.  

The ruler scale is set to pixels, and the position indicator in the status bar (if Show Position is checked 
on the View menu) also displays positions in pixels. 

PLANNING DATA PLACEMENT 

Once you have a report layout, you can modify the placement of the data on the report page. Using the 
bands in the Report Designer, you can control where data is printed on the page. Your report layout can 
have several bands. The figure below shows some of the bands a report can include and typical 
contents for each band. Notice that the bar below each band identifies the band. 

REPORT BANDS IN THE REPORT DESIGNER 

A report can also have multiple group bands or bands for a column header and footer. You can add 
these bands using the procedures in Defining the Report Page and Grouping Data on Your Layout later 
in this chapter. You can use the table below to determine which bands you want to use. 

Use this 
band 

To print Use this command 

Title Once per 
report 

Choose Title/Summary from the Report menu. 

Page 
header 

Once per 
page 

Available by default. 

Column 
header 

Once per 
column 

Choose Page Setup from the File menu and 
set Column Number greater than 1. 

Group 
header 

Once per 
group 

Choose Data Grouping from the Report menu. 

Detail band Once per 
record 

Available by default. 

Group Once per Choose Data Grouping from the Report menu. 
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footer group 

Column 
footer 

Once per 
column 

Choose Page Setup from the File menu and 
set Column Number greater than 1. 

Page footer Once per 
page 

Available by default. 

Summary Once per 
report 

Choose Title/Summary from the Report menu. 

You can place any of the report controls in any of the bands. You can also add user-defined functions 
that are processed when the report is run. . 

RESIZING BANDS 

You can modify the size and characteristics of each band. 

To resize a band Drag the band’s bar to the appropriate height.  

Use the ruler to the left as a guide. The ruler’s measurement is specific to the height of the band and 
does not include the page margins. 

Tip   You cannot make a band shorter than the height of the controls in the layout. Move the controls 
within the band first, and then reduce the height. 

DATABASE DICTIONARY 

To add fields that contain data from the Dynamics databases, please refer to the included Database 
Dictionary, which are in 3 Adobe Acrobat PDF files found in the S:\MESSENGER\LMCsetup\Doco 
folder. 
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10 ‐ UPGRADING LIAISON MESSENGER 

These are the recommend steps you should follow when upgrading Liaison 
Messenger from version 3.x to 4.x. However,  it would also apply to older 
versions 2.x and earlier; but, the Exe file names would be different. All other 
steps would be the same. 

YOU MAY BE REQUIRED TO REBOOT THE MACHINE AT THE END OF 
THE INSTALLATION 

1. Exit Messenger Clients on the workstations  

2. Delete all existing jobs from the Queue in Messenger Server. (File \ Services Monitor–
History/Queue) Single click the line and click Delete Print Job. Exit and close down the Liaison 
Messenger Server application. 

3. Go to existing (i.e., S:\MESSENGER) folder where Liaison Messenger is installed on the network 
and make a copy of all files that begin with the letters LM*.* and place them in a safe folder. 

4. Rename LIAMSG30.EXE to LIAMSG30.OLD  

5. Rename FLLINTF210.FLL to FLLINTF210.OLD (ignore if this file does not exist) 

6. If you will be installing Liaison Messenger 4.0 into a new folder, we recommend following these 
simple steps (a thru c) before running the setup.exe in Step 7: 

a. Rename the existing Liaison Messenger folder (i.e., S:\MESSENGER to 
S:\MESSENGER30) 

b. Create a new folder using the exact same folder name (i.e., S:\MESSENGER) 

c. Copy the LM*.* files from the renamed folder into this new folder S:\MESSENGER30 to 
S:\MESSENGER. This will ensure your previous configuration will be maintained thru the 
upgrade. 

7. Insert the Liaison Messenger 4.0 CD and run SETUP.EXE file. Rest assured, this installation 
program will not overwrite any settings, preferences, or routings from the existing Messenger 
version. All existing configurations will remain intact. 

8. At the prompt, choose Messenger Server Installation from the Setup Options window.  

9. Select the directory where Messenger is installed. This folder should either be:  

a. The new Messenger folder you may have just created, or 

b. the existing folder where the original LIAMSG30.EXE was located, then 

c. click Yes when the prompted.  
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10. Once the installation has finished, click OK to accept the default program group.  

11. During this process, a new version of the Liaison PDF driver will be installed. This version is 
compatible with 64 bit operating systems. Click OK when the progress screen completes.  

12. You may also be prompted to add the MAPI registration information into the Windows registry. 
You must select Yes.   

13. At this point, you may be prompted to allow the system to reboot and you should allow this by 
selecting OK. Restart the PC; but, do not launch the Messenger Server program, yet. 

14.  If you have previously made any manual shortcuts, you will want to update the Target fields to 
reflect Liaison Messenger's new file name. This is done by right-clicking any Liaison Messenger 
Server shortcuts and choosing Properties. Change the name of the executable in the Target field 
from LIAMSG30.EXE to: 

a. LIAMAS40.EXE (for users of PFW, MAS90/200) 

b. LIAMBS40.EXE (for users of Dynamics GP or Dynamics SL) 

c. Repeat this for any other shortcuts on the desktop or sub-menus that have been created 
for Messenger Server. The Messenger Clients do not need to be updated as the file 
name did not change. 

15. Launch Messenger Server. An update procedure will begin. When the update is complete click 
OK and the Messenger Server will close.  

16. Launch Messenger Server again and it should now open to the Server Status window and the 
stop-and-go icon should be at a green light. This confirms the update was successful. 

17. Exit Liaison Messenger Server for now.  It is now time to upgrade the Messenger Clients on 
each workstation.  

18. Using the same CD (or the setup.exe file if you copied the Setup.Exe onto the network) launch 
setup.exe and choose the Liaison Messenger Client option and click OK.  

19. Select the network directory where Messenger is installed (i.e., S:\MESSENGER). The actual 
existing path can be verified by right-clicking the shortcut to Messenger Client and choosing 
Properties. Click Yes when the prompt appears confirming the directory.  

20. Once the installation is finished click OK to accept the default program group.  

21. Repeat steps 18 through 20 on the other workstations running Messenger Client until all 
workstations have been upgraded.  

22. Return to the Liaison Messenger Server and start it.  

From the File menu, choose System Configuration and immediately click the Save button and If you are 
asked 'Do you want to start the Messenger services, (Green Light)?' answer Yes. 
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11 ‐ MOVING THE LIAISON MESSENGER 
SERVER 

STEPS FOR MICROSOFT DYNAMICS GP/SL 

These are steps required when wanting to move Liaison 
Messenger from one machine to a different machine. 

 

These instructions are for moves where the Liaison Messenger files and data will stay in same network 
folder\directory but the Messenger Server will run from different machine (see additional steps at bottom 

for moving to new directory). 

1. Install all 3
rd 

Party Software on new machine (Outlook, Winfax, Adobe Acrobat, etc)  

2. Create ODBC Data Sources for the System database (Dynamics) and each company 
database you wish to run with Messenger. Best to keep the data source names the same as 
those on the original Messenger Server machine.  

3. Delete all entries in the Queue on the original Messenger Server.  

4. Close all Messenger Clients and the Messenger Server on the original machine and copy all 
LM*.* files from the Messenger folder to a backup folder.  

5. Install Messenger Server from the CD on the new machine. Point the installation path to the 

existing Messenger folder.+++  

6. Launch Messenger Server from new machine and let the update process run.  

7. Click OK when update is complete. Close Messenger Server.***  

8. Run the latest update for Messenger on the new machine. (setupdte.exe) Be sure to follow 
the separate instructions for the update. After the update is complete click OK then reopen 
Messenger Server.  

9. Go to File | System Configuration.  

10. Reselect the Default Printers on the Messenger tab.  

11. Verify/change the Dynamics Data Source under the Database tab.  

12. If using WinFax PRO, choose the Faxing tab and reselect the WinFax driver and the location 
of WFXCTL32.EXE  
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13. Choose the Emailing tab and reselect the Attachment printer driver. (Liaison Messenger 
PDF or Acrobat PDF Writer)  

14. Choose the Archiving tab and reselect the Archiving printer driver. (Liaison Messenger PDF 
or Acrobat PDF Writer)  

15. Click Save then click No if asked to restart the server.  

16. Go to File | Select Company Dataset. Click the desired company and choose Company 
Configuration.  

17. Click the SQL Server tab and verify/change the Company Data Source.  

18. Click Save then single click the company and click Select.  

19. Go to File | Properties.  

20. You will need to reselect the printer for each ply and any bitmap locations for the Return 
Address. Repeat this for each form tab.  

21. If installing to a new network folder, the shortcut to Messenger Client on each workstation 
will need to be changed to the new path.  

+++ IF INSTALLING TO A NEW MESSENGER FOLDER POINT THE INSTALLATION TO 
THE NEW MESSENGER FOLDER.  

*** IF MOVING THE NETWORK LOCATION OF THE MESSENGER FILES YOU WILL 
NEED TO COPY THE LM*.* FILES FROM THE OLD MESSENGER DIRECTORY TO THE 

NEW ONE OVERWRITING THE EXISTING FILES. THIS WILL BE DONE BETWEEN 
STEPS 7 AND 8. 
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STEPS FOR PFW BY SAGE SOFTWARE INC 

Follow these steps to move Messenger Server from Platinum root directory to new Messenger folder. (or 
different Platinum directory)  

1. Create Messenger folder in desired location.  

2. Install Messenger Server from CD into the new folder.  

3. Open Messenger from the new folder- an update procedure will run.  

4. After clicking OK if System Configuration opens click Save (diskette icon upper left)  

5. Close Messenger – both the new one and the existing one.  

6. Make sure everyone is out of Messenger Client.  

7. Copy the LM*.* files from the existing Platinum directory to the new Messenger folder.  

8. Run the latest update (setupdte.exe) pointing to the new Messenger folder.  

9. (Or if installing from latest setup file open Messenger Server and choose Run Update from Tools 
menu)  

10. Open Messenger Server (messenger folder). The update procedure will run and notify you when 
complete.  

11. Click OK – Messenger will close  

12. Open Messenger.  

13. From the Tools Menu choose Modify Company Data Paths.  

14. The lmdcfg table will open.  

15. Scroll to the right to locate the column Approot.  

16. Change the path for each to your platinum root directory.  

17. Click the close “x” to save the changes.  

18. Go to File > Select Company Dataset.  

19. It will pull up the companies listed under PFW.  

20. You can then highlight a Company; click Company Config and Enable For Messenger if not 
already checked.  

21. Click the Email/PSQL tab then click the yellow lookup button on the right to select the correct 
company data directory.  

22. Click Save.  
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23. Highlight your company key and click Select.  

24. Click No when it asks you to restart the Server.  

25. Next go to File Properties to verify your ply settings and printer mappings.  

26. You can click the Preview button to test the connection to PFW.  

27. If you are also running Liaison CRM you will need to still keep all the Messenger files in the 
Platinum root directory. This is needed to do recreates through CRM.  

28. You will need to change the shortcut to Messenger Server.  

29. You will need to change the target for Messenger Client on the workstations to the new 
Messenger folder. 
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12 – TROUBLESHOOTING  

ERROR CODES 

BTRIEVE STATUS/ERROR 88 – INCOMPATIBLE MODE ERROR 

Resolution - This happens when the Btrieve / Pervasive.SQL client 
engines are set to Single Engine. You must configure 
Btrieve/Pervasive.SQL engines a Multi-Engine. This includes the 
NT machine acting as the DAS and/or where Messenger Server is 

running. 

MESSENGER ERROR 15 – NOT A DATABASE ERROR 

This happens from turning off the PC/Server without exiting Messenger Server. Most likely the user had 
a power outage. Unfortunately, they have to restore the LMD*.* files from their last backup into their 
Dynamics root directory. 

MESSENGER ERROR 36 – COMMAND CONTAINS UNRECOGNIZED PHRASE/KEY 

This happens when Archive to Disk is used and the Constant Folder/Directory Path contains embedded 
spaces (i.e., I:\DYNAMICS\TWO_INC\SALES ORDERS\). When creating folders for archiving, do NOT 
use folder names with embedded spaces. 

MESSENGER ERROR 107 ‐ OPERATOR / OPERAND MISMATCH 

(*Applies to Liaison Messenger 1.5D and before.) 

This error occurs when the last Messenger update is not run after the Messenger client was installed on 
a new workstation(s).  

WHEN INSTALLING AN UPDATE 

 Make sure everyone is out of Messenger server and client 

 Run the setup program and install it on the Dynamics directory on the network 

 When finished, start Messenger server and let Messenger server complete the update process 
(from 15 seconds to 4 minutes) 

 When complete you will be required to restart Messenger server 

 

* If you are installing more messenger clients rerun the update procedure after a new client is installed. 
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* The installation of Messenger client on a new 
workstation(s) will not be complete until the last update is 
run. 

MESSENGER ERROR 1705 – FILE ACCESS DENIED 

This can happen when using the archive e-mailing 
feature in Messenger and when the View PDF File 
option is turned on (checked) in Acrobat’s save file 
dialog box. 

Resolution:  

1. Login to the DAS as Administrator. No other login 
name will work 

2. Open up Microsoft Word or WordPad 

3. Select File, Page Setup, then Printer… 

4. Choose the Acrobat PDF writer as the printer destination 

5. Print the document 

6. Uncheck the View PDF File 

MESSENGER ERROR 1957 – ERROR ACCESSING PRINTER SPOOLER 

Resolution – This happens when the form/ply’s Printer Mapping no longer exists. Go into Messenger 
Server and reselect the desired printers. This typically happens when Messenger Server is started and 
configured from a PC is not going to be the PC running the Messenger Server program in production. 
Remember, the printers may physically be the same but the way Window 98/NT maps them may vary 
machine to machine. Always configure Messenger Server from the PC that will be running Messenger 
Server. 

MESSENGER/COLLECTOR (EXCLAMATION POINT MESSAGE BOX W/ OK HELP BUTTONS) ‐ INVALID 
PATH OR FILE NAME. 

They have specified a bitmap to use as their Logo and someone deleted or moved the <logo>.BMP file. 
Go into the respective Form and Ply and relocate the BMP file. 

TIPS FOR THE INSTALLER 

BTRIEVE/PERVASIVESQL 

Whichever PC is going to be the Messenger Server, make sure the PC has btrieve/Pervasive client 
engines installed and are consolidated in the directory recommended by Pervasive.   
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Also make sure that the client engines are configured for Multi-Engine and that sufficient file handles 
and record locks have been specified. 

ESTABLISHING PRINTER MAPPINGS 

Please be aware that you cannot configure 
Messenger Server from any workstation other than on 
the PC/server that Messenger Server will be running. 

UNABLE TO LAUNCH LIAISON MESSENGER CLIENT 

Sometimes Microsoft's  Data Execution Prevention feature 
prevent Messenger Client from starting when the User 
chooses the icon/shortcut from their desktop.  To correct: 

1. Right click My Computer | Properties 
Choose Advanced tab 
Click Settings under Performance section 

2. Choose the Data Execution Prevention tab 
Select the ‘Turn on DEP for all programs and 
services except those I select’ button 

3. Click the Add button and select the LIAMCLI.EXE 
from the Messenger folder 
Click Apply.   

4. Windows will need to be restarted in  order for 
the changes to tab effect. 
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13 – WHAT’S NEW IN LIAISON MESSENGER 

LIAISON MESSENGER® 4.0 ENHANCEMENTS 

Listed below are some major enhancements for Liaison Messenger 4.0. This major version upgrade of 
Liaison Messenger was made available in the 1st Quarter of 2008 for users of Sage PFW and 
MAS90/200 and has had periodic maintenances updates to include Sage PFW 5.7 in the 4th Quarter of 
2008. 

The Liaison Messenger 4.0 release for Microsoft Dynamics GP and SL is scheduled for release during 
the 1st Quarter of 2009. 

BROADER APPLICATION INTEGRATION 

Messenger is now integrated into the following products through their most current respective versions. 

 Sage MAS*90 v4.3 

 Sage MAS*200 v4.3 

 Microsoft Dynamics v10.0 

 Microsoft Dynamics GP EFT-AP or EFT-DD (EFT) v10.0 

 MBS Solomon/Dynamics SL v7.0 

 Microsoft Dynamics GP/Dynamics GP v10.0 

 Sage PFW v5.6 

 Sage PFW v5.7 

BROADER OPERATING SYSTEM AND SERVER INTEGRATION 

 Windows Vista 

 Windows Server 2008 

 64 bit Windows Platform/Operating Systems; Client & Server 

 SQL Server 2005 Certification 

IMPROVED USER INTERFACES 

Redesigned Messenger Client Interfaces 

Updated Messenger Server Interface 

OPTIMIZED SQL VIEWS 
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Greatly improved processing speed of unattended processing for Dynamics GP & SL SQL based 
installations.  

TEXT MESSAGING/SMS CAPABILITIES 

Internal recipients can now receive SMS/text messages and alerts to their supported cellular/mobile 
devices when select documents and plies are created or have advanced through the document's 
workflow. Internal error notifications can now be sent to IT personnel via cellular/mobile devices 
immediately notifying them of critical changes or problems within their Liaison Messenger hardware and 
or software environment. 

BROADER FAX SERVER INTEGRATION 

Liaison Messenger included direct support for more internet based fax service companies and 
integrated Fax Board solutions. 

BROADER E‐MAIL INTEGRATION 

 Eudora 

 Microsoft Mail 

 Microsoft Outlook/Office 2007 

 Novell GroupWise 

MISCELLANEOUS FEATURES 

Liaison Messenger PDF Driver 

 Font Embedding 

 128 Encryption 

 64-bit compatibility 

 LPT2, LPT3, and custom port and assignments for Terminal Service/Cytrix 

Internal/External Dialing Configurations for faxing state dialing schemas 

Microsoft Dynamics GP - Unattended Processing for Posted (historical) SOP documents 

LIAISON MESSENGER® 3.0 ENHANCEMENTS 

BROADER INTEGRATION 

Messenger is now integrated into the following products through their most current respective versions. 

 Sage MAS*90 – 1st Quarter 2006 

 Sage MAS*200 – 1st Quarter 2006 
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 Microsoft Dynamics SBF – 3rd Quarter 2005 

 Microsoft Dynamics GP EFT-AP or EFT-DD (EFT) – 3rd Quarter 2005 

 MBS Solomon/Dynamics SL – 1st Quarter 2004 

 Microsoft Dynamics GP/Dynamics GP – 3rd Quarter 2002 

 Sage BatchMaster/pfw/ERP*100 – 3rd Quarter 2000 

 Sage PFW/ERP*100 – 2nd  Quarter 2000 

MULTIPLE DOCUMENT DISTRIBUTION DESTINATIONS 

Messenger now supports multiple recipients per document. Process documents simultaneously to the 
National Account, Bill-To, and Ship-To address.  Perfect for large customers who require centralized 
payment process to Corporate HQ, Advanced Ship Notifications to Ship-To, and Order Fulfillment 
Notices to purchasing facilities (Bill-To). 

NEW ‐ MICROSOFT DYNAMICS GP, EFT‐AP MODULE & DIRECT DEPOSIT MODULE 

For users of Microsoft Microsoft Dynamics GP, Liaison Software Corp released Messenger EFT for 
Electronic Distribution of Vender Payment Notice. Automatically distribute electronic voucher statements 
upon Electronic Fund Transfers using Microsoft Dynamics GP EFT-AP module. 

ENHANCED SEARCHING CAPABILITIES 

Locating Customer/Vendor Preferences is much easier now. Search by name; fax number; or e-mail 
address – no more scrolling through your complete list of Customers or Vendors. Also, searching for 
Archived documents in the Archive Manager has improved. 

USER‐DEFINED INDEXED AND SORTS 

Create unique indices and sorts on a ply-by-ply basis. Great for creating Summary Invoices, Inter-
Company Statements, Bills-of-Ladings, Shipping Docs, etc…  

USER‐DEFINED FORM SIZES  

Create unique or odd sized form sheet sizes using the Windows Printer Drivers and bind them to a 
specific Form Template. Perfect for creating or implementing unique, landscaped dot-matrix forms. 

OPTIMIZED SQL VIEWS 

Greatly improved processing speed of unattended processing for Dynamics GP & SL SQL based 
installations.  

BROADER FAX SERVER INTEGRATION 

Liaison Messenger included direct support for Microsoft Fax Transport, RightFax, GFI Fax, and ZetaFax 
as well many internet based fax service companies. 

REAL‐TIME ERROR NOTIFICATION PROCESS 
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Automatically email internal individuals and/or Liaison Software Corp’s Technical Support department 
should an unplanned error momentarily interrupts Messenger processing abilities. 

REAL‐TIME PRINTER ERROR HANDLING 

Automatically re-route a print job to a backup printer in the event the intended printer disconnect due to 
networking or hardware issues. 

FULL‐ROUTING OPTIONS ON RECREATES 

Rerun an entire process of Posted Documents to include all plies. 

ALTERNATE RECIPIENT PREFERENCES 

Used for exception routing. This feature can also be used to distribute Sales Literature or Promotion 
blasts in conjunction with Messenger Client Statement processing. 

AUTOMATED PROCESSING FOR MULTIPLE TYPES OF ORDERS 

Before Messenger 3.0 Unattended processing was only available for one or all stages of an 
order/invoice, i.e. New Orders OR Back Orders OR Quotes, etc. Version 3.0 allows you to configure 
multiple status types of orders for unattended processing.  

ADD VARIABLE FILE ATTACHMENTS TO E‐MAILS 

Now you can add variable file attachments to an order based specific to Customer Key, Vendor Key, or 
Document Number. 

ADD STATIC FILE ATTACHMENTS TO E‐MAILS 

Now you can add static file attachments to an order, i.e. 

Add Terms and conditions to a Purchase or Sales Order 

Attach a Credit Application for those customers set up as COD, etc. 

Send out promotional literature with every Invoice or Sales Order 

CREATE MULTIPLE E‐MAIL DESTINATIONS PER RECIPIENT 

E-mail addresses can be entered delimited by semi-colons to allow multiple recipients per form ply. 

SCHEDULE STATEMENTS TO PRINT AUTOMATICALLY ON A SPECIFIC DAY OF THE WEEK 

Added the ability to process statements on a given Day of the Week and a specific time. Can be used in 
conjunction with the real-time processing features found in Liaison Collector. 

ALLOW ARCHIVED ORDERS TO BE ARCHIVED AS INDIVIDUAL PDFS RATHER THAN GROUPED. 

Makes it easier to retrieve archived documents – Each archived form is assigned its own PDF instead of 
being grouped by batch. 

CREATE INDIVIDUAL FAX COVERSHEETS 

Now you can create fax coversheets specific to your customer or vendor needs. You can also create a 
coversheet by ply, for example, create an order acknowledgement ply that.  



I N S T A L L A T I O N  G U I D E  

 

73 

Liaison Messenger® v4.0 

 

OUTPUT FORMS TO DISK 

More and more applications wish to integrate and communicate via disk files Spreadsheets, dBase files, 
SDF files, comma delimited, space delimited. Here you can specify a particular file type into a specific 
directory for a third party application to pick up and read. i.e. credit card processing and fulfillment 
applications. 

CREATE PLIES TO PRODUCE A VARIETY OF OUTPUT FILE FORMATS 

 

ENHANCED PREPAYMENT CAPABILITIES 

Previously in PFW, when you went to print the Invoices: 

The payment was put on account so someone has to go into PFW and manually apply that payment on 
account to the respective Invoice. 

It would never show that an order had a prepayment on the Invoice so the Invoice displays the original 
amount, not reflecting a prepayment. 

 

SOLUTION: Prepayments are displayed on the applicable Invoice. This option delays the processing of 
the payment deposit until an Invoice is printed in Messenger, then an Invoice number is assigned to the 
payment before it is written to PFW. 

SHIPPING DOCUMENTS PREFERENCE AND RECREATE 

Shipping documents can now be automatically processed like Sales Order and Invoices. Using 
BatchMasterPFW’s option to automatically print shipping docs Messenger now reads this 
BatchMasterPFW option and will print and update the shipping documents and Packing Slips without 
affecting the attached Invoice. 

INCREASED SUBJECT LINE ON E‐MAIL SENDS 

Subject line has been increased from 30 characters to 254 characters 

SELECT INDIVIDUAL PLY FOR “PREVIEW/TEST PRINT” 

CHANGE PLY ORDER FUNCTION 

Now you can change the order of how your plys appear in Messenger server 

CLONE PLY FUNCTION 

Easily clone all the settings from ply to new ply. 

LIAISON MESSENGER 2.1/2.5 ENHANCEMENTS 

This mid-release version of Messenger was made available in the 3rd Quarter of 2002. It was primarily a 
maintenance release for PFW due to their latest release of PFW 5.1. Customer with an active support 
maintenance agreement received this update at no charge. 
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BROADER INTEGRATION 

In addition to the database conduits for PFW 5.1, Liaison proudly release the highly anticipated Liaison 
Messenger 2.5 version which provided database conduits for Microsoft Dynamics GP/SBF (aka, 
Dynamics and eEnterprise) through version 7.0. 

LIAISON MESSENGER 2.0 ENHANCEMENTS 

Liaison Messenger was released in the 3rd Quarter of 2001 and included a large number of 
enhancements and new features as requested from our growing Liaison Messenger and Collector user 
base. 

FEATURE SUMMARY 

Liaison Collector merged into Liaison Messenger 

Auto-add Recipients 

Archive Manager 

Auto Routing for Salesperson, Territories, and Locations 

Bill of Ladings and Shipping Documents 

Liaison CRM Integration 

Auto Purge History 

Multi-Page/Continued Capabilities 

International Dialing Settings 

Lookup Tables for Customer and Vendors 

Include Kitting Items on Invoices and Sales Orders 

Messenger Client accessible in Messenger Server 

Desktop e-mailing and faxing from Messenger Client Recreate 

LIAISON MESSENGER 1.5 ENHANCEMENTS 

BROADER INTEGRATION  

In the 4th Quarter of 2000, Liaison Software Company, LLC announced the maintenance release of 
Liaison Messenger. The primary purpose of this release was the release of the database conduits for 
BatchMasterPFW. 
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LIAISON MESSENGER 1.0 RELEASED 

In the 2nd Quarter of 2000, Liaison Software Company, LLC released Liaison Messenger 1.0 and Liaison 
Collector 1.0.  


